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FOR FRUITYLOOPS 3.x and FL STUDIO v4.x USERS

This guide is current to Version 5 of FL Studio. If you were the proud owner of one of the FruityLoops 3 versions (good for you!) or FL Studio v4 (even better), then read on to see what's new in this version.

1. FL Studio Name.  Since version 4, the name of the product changes to FL Studio. FL Studio contains all the stuff you know from FruityLoops 3.x and much more!

2. Mixer XE "piano roll" .  The effects window from FruityLoops 3.x is now a full-blown mixer with 64 insert tracks, 4 send tracks, per-track equalizer, balance controls and disk recording. You can also create complex mixer setups by routing the insert tracks to each other!

3. Playlist. New Piano Roll style showing the correct pattern lengths, supporting live mode pattern mixing and brand new audio tracks are some of the improvements integrated in the new Playlist window.

4. Per-Pattern Grid Length. In previous releases, the Step Sequencer had one fixed length for the entire project. Now you can adjust the sequencing grid for each individual pattern!

5. New in this version … XE "FX Tracks" .  Check out the new generators and effects in this release! Check out the WhatsNew.doc in the main FL Studio directory for a brief run down of what else is new 

INSTALL INSTRUCTIONS

There are two ways to purchase FL Studio: on line, or in a box with a CD and this printed manual. The installation differs slightly in each of those cases. Read here what to do:

A. If you bought your copy of FL Studio in a box, here's what you do.  

1. Run the CD. Insert the install CD-ROM that comes with your box in your CD-ROM drive. If you have auto-run enabled, you will see the CD menu automatically appear. Otherwise, right-click your CD-ROM drive icon in Windows Explorer and select Autorun.


2. Start the Installation. Select the FL Studio installation link. The installation window appears. Follow the instructions on screen.


3. The Serial Number. During the installation you will be asked for you serial number. You can find it printed on your CD-ROM case. Write it down for further use and make a backup of this number.


4. Register On-line. After you complete the installation successfully you can register on-line to gain access to the extra FL Studio website features and community. Go back to the CD-ROM menu (reload as described in step 1 if needed), and click on the link called “Click here to register to the FL Studio community” or go to this link http://www.flstudio.com/FLBoxRegistration.


5. In case of problems. Please consult our F.A.Q. section on our website www.flstudio.com. Useful information about known issues can be found there.

B. If you bought your copy of FL Studio on line, here's what you do.  

6. Download and Install the Demo. Download and install the demo version of FL Studio. It is recommended NOT to install over previous releases of FL Studio/FruityLoops.

7. Apply for a Regcode. Go to www.flstudio.com/register and enter your username and password you received by e-mail after your purchase. Click the button below to your regcode to pop-up.


8. Wait for the E-Mail.  The FL Studio team will send you an e-mail with a link. Make sure your email account can accept emails coming from us (domain: e-officedirect.com). Please follow all instructions carefully. 


9. Run the Program. Restart FL Studio if it is running and you will be able to save your projects.

10. Bookmark the Web Site.  The FL Studio web site is an awesome resource.  Check back at http://www.flstudio.com/ XE "FruityLoops.com"  often to see what's up.

11. Read this Guide.  As soon as you start FL Studio, you'll be confronted with strange dialog boxes and messages.  Proceed to the next section of this guide to find out what to do next. Also check the extensive on-line help that comes with FL Studio.

FIRST RUN

OK, so you just finished the installation and started FL Studio.  Read this section for an explanation of what you're seeing.

1. The System Settings XE "environment settings"  Screen. When you first run FL Studio, you may be confronted with a dialog box like the one below (if not, use F10 to bring it up now).  You just have to use the select boxes to choose your sound card and MIDI drivers XE "MIDI:drivers" .  At first, you may be looking at the MIDI screen, but for now the most important one is the Audio screen XE "Audio Settings" , shown below.
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2. Select an Output Driver from the list in the pull-down menu.  If you don't know which one to pick, just leave it as it is.  Later on if you have sound problems, you can come back to this screen (by pressing F10) and experiment with the other options.

3. The DirectSound Streaming Buffer XE "DirectSound streaming buffer" 

 XE "buffer length" .  Most of the stuff on this screen you don’t need to know about, but you should know what the Buffer Length does. Basically, if you make this buffer long, you are less likely to get choppy sound XE "choppy sound"  but changes you make to a playing loop will take longer to kick in.  If you make it short, you are more likely to get choppy sound but changes will kick in faster.  You want it short, but depending on your computer, you may need to come back to this screen later (F10) and make it longer.  If you have a combination of a fast computer and a good sound card, you may be able to get the latency as low as 10ms.  For a SoundBlaster XE "SoundBlaster"  Live, you can probably go as low as 30ms.  The 



Use Polling XE "polling"  option can also improve latencies for some operating systems (keep it turned on if you use Windows XE "Windows"  95 or 98, but try switching it off in Windows 2000 to see if it brings better performance). 

4. The Main Screen.  After you close the Environment Settings XE "environment settings"  window, you'll be looking at a screen like the one below.  FL Studio is all about windows within windows.  So you're looking at the outer Main Window XE "main window"  with its Tool Panels at the top.  Then within that you're looking at the Browser XE "browser"  (left) and the Step Sequencer XE "step sequencer"  (right). The panels might be arranged differently for you, but that doesn’t matter.
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MAKE SOME NOISE

Press the Play Switch XE "play switch" .  This is the button on the Transport panel (next to the stop and record buttons).  You'll hear the FL Studio 3 demo song.  If this is not the first time you've run FL Studio, you'll have to reload this demo.  Select Open from the File menu in the top left and double click the file NewStuff.flp XE "NewStuff.flp"  in the Loops directory.  

 XE "Lemon Boy"

 XE "volume"

HELP!

This booklet is just supposed to get you up and running quickly.  It is not meant to be a reference manual for everything FL Studio can do (that would take a multi-volume XE "volume"  encyclopedia!).  Fortunately, there's a ton of info out there on what FL Studio does.  Here's how to get it.

1. The Hint Bar XE "hint bar" . This is located on the Main Window XE "main window"  just under the Menu Bar XE "menu bar"  (see the previous page, in the top left).  You can mouse over any of the controls anywhere in FL Studio and this panel will display a short description of what that control does.  The Hint Bar also shows you the Shortcut XE "shortcuts"  Key that will activate the same function.  This is displayed on the right.  Pressing this shortcut key has the same effect as pressing the corresponding button.

2. On-line Help.  FL Studio also comes with a massive on-line help XE "on-line help"  reference.  Just use the Help Menu and select Contents. This help also features context-sensitivity – select a window and press F1 on your keyboard. The reference automatically displays the help you are looking for.

3. Tutorial XE "tutorials"  Loops.  Click File >Open and surf to the Tutorials directory.  These loops contain notes on how to do various things in FL Studio.

4. The Web Site.  FL Studio comes with a massive web site at http://www.flstudio.com/ XE "FruityLoops.com" .  The site has a support section that includes a FAQ XE "FAQ"  and a Discussion Forum, Online Tutorials, Video Tutorials (soon), Song Exchange section and the Samplefusion samples site XE "discussion forum" .  Check these to see if anyone has answered your questions already.  If not, feel free to post your own question on the discussion forums.

GET THE "GETTING STARTED" LOOPS

To use this guide effectively, you should find and load the "Getting Started" loops that were included in the FL Studio package.  Go to the File menu (above the Hint Bar XE "hint bar" ) and click on Open.  Alternatively, click on the File Open Icon below the Hint Bar.  Either method will get you a file dialog box open on the Loops Directory.  From here, double-click the Tutorials XE "tutorials"  Subdirectory, and then the Getting Started Subdirectory and you will see the Getting Started Loops XE "Getting Started Loops" .  Load up the first one (GettingStarted1 XE "Getting Started Loops:GettingStarted1.flp" .flp), press Play and move on to the next section! XE "Lemon Boy"
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THE STEP SEQUENCER

When you start FL Studio for the first time, you'll see the Step Sequencer XE "step sequencer"  window (see the “First Run” section).  This is where you lay out your drum and melody patterns for your songs.

1. What is it For? This is where you find channels, and dots XE "dots" .  The channels are laid out horizontally (see below) and each one contains a single sound.  Each channel has 16 dots.  If you're musically inclined, these dots represent 16th notes.  If not, think of each group of four dots as one beat, so 16 dots are the four beats of a basic drum loop.  (The layout below is from GettingStarted1 XE "Getting Started Loops:GettingStarted1.flp" .flp.  You should have this loop loaded now.)
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2. What Dots XE "dots"  are For?  Clicking on a dot lights it up and tells FL Studio to trigger the channel (play the sound loaded into that channel) at that point in the loop.  For instance, the 1st, 5th, 9th, and 13th dots in the DNC_Kick channel are lit up, telling FL Studio to play the kick drum sound four times during the loop (if you are thinking of groups of four dots as a single beat, FL Studio will play the sound at the start of each beat.)  Try changing the pattern of dots in the DNC_Kick channel. (If you need to turn a dot off, right-click it.)  Once you've got the dots to light up like the picture below, press the play switch XE "play switch"  to hear what you've created.
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3. Play with the Channel Controls. After you've set up the pattern, try playing with the Channel Controls on the left.  The two round knobs (wheels) control the volume XE "volume"  and pan XE "pan"  of a single channel, and the green light switches the channel on and off (panning is like the balance XE "balance"  control on your stereo; turning this knob moves the sound from left to right in the stereo field).  If you want to reset a wheel to it's default position, right-click on it and select reset.
4. Make Your Own Beat. Don't like the beat above?  Good, make your own! In the next sections, we'll teach you how to load in new samples, set up melodies, and change the sound of each channel (and even each dot XE "dots" ) using Plugin Effects XE "Fruity effects" .

 XE "Lemon Boy"
[image: image135.wmf]
TWEAKING THE CHANNELS

In this section, we'll show you how to modify the sound of the loops you create by tweaking the sound sample XE "samples"  on each channel.  FL Studio supports so much of this kind of tweaking that it's possible for two people to create loops that sound totally different using exactly the same samples (technically, each channel contains a Generator, which could be sample-based or could be a synthesizer plugin XE "plugin" . More on that later, though).

 XE "Lemon Boy"

 XE "samples"
[image: image136.wmf]
1. Open the Channel Settings XE "channel settings"  Dialog.  OK, let's get going and modify the kick drum sample XE "samples" .  Load up the original version of GettingStarted1 XE "Getting Started Loops:GettingStarted1.flp" .flp again and click on the name "DNC_Kick" to bring up the Channel Settings window for that channel (shown in the picture below).
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2. Load a New Sample XE "samples" . The first thing you can do is change the sample being used on the channel.  The sample file name is shown on the picture above.  Clicking on the file icon to the left will open a browser XE "sample browser"  on the directory containing the file "DNC_Kick.wav" along with a number of other kick drum samples.  As you click on them, FL Studio will automatically play the sounds for you.  Try opening some of these other samples and listening to the effect a new kick drum has on the sound of the loop.

3. Check out the Browser XE "browser" 

 XE "sample browser" . Another way to load samples is to use the Browser (that's the other window you see when you first opened FL Studio in the "First Run" section above.) This is a special browser for selecting and loading samples, loops and presets files.  To find the DNC_Kick sound, click on Packs, and then Dance.  Left-clicking on a sample will play it, right clicking will open it into the selected channel, and you can also drag and drop into the step sequencer XE "step sequencer" .  (You select a channel by clicking on the green Channel Selector XE "channel selector light"  light to the right of the channel name as shown above.)

 XE "Lemon Boy"
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4. Play with the Sample XE "samples"  Effects. Ok, at this point the best advice is to start the loop, then play with the controls in the sample (SMP XE "channel settings:sample panel" ) panel of the Channel Settings XE "channel settings"  Dialog and listen to the difference in sound.  Here's a short description of what some of them do. For more info see the on-line help XE "on-line help" . 
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5. Add Some Echo XE "delay (echo)" 

 XE "echo (delay)" .  Go back to GettingStarted1 XE "Getting Started Loops:GettingStarted1.flp" .flp, open the DNC_Kick channel settings XE "channel settings"  and click the FUNC XE "channel settings:func panel"  tab to get the view shown below.  The controls in the top section (Echo delay / fat mode XE "fat mode" ) can be used to set up a cool echo effect for a single instrument.  Start by turning up the FEED about a quarter of the way, and listen to what happens to the kick drum sound…  Try playing with the other controls to change the sound of the echo… You can also toggle between various echo and “fat” modes by clicking the title bar of the Echo Delay section (the default is Classic Echo). More on these different effects can be found in the on-line manual…
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 XE "Lemon Boy"

6. Play With the Instrument Settings.  Ok, let's take a quick look at the INS XE "channel settings:instrument panel"  panel before we move on.  (There's also stuff you should read about in the MISC XE "channel settings:misc panel"  panel too, but you can get that info from the On-line Help.)  Click on the INS tab and you'll get to the Instrument Settings.  Here you can add Envelopes XE "envelope"  and LFO XE "LFO"  to your sample XE "samples"  for the Volume XE "volume" , Pan XE "pan" , Cutoff XE "resonance & cutoff" 

 XE "cutoff & resonance" , Resonance, and Pitch XE "pitch"  settings. 
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7. What's an Envelope XE "envelope" ? An envelope causes a particular parameter to rise, and then fall over the life of the sound. The most classic thing to do is to have a Volume XE "volume"  Envelope that makes the sound rise then fall in volume. But you can also put an envelope on Pitch XE "pitch" , Cutoff XE "resonance & cutoff" 

 XE "cutoff & resonance" , and Resonance.  You can get more info on what all the parameters mean in the On-line Help, but Delay XE "delay (echo)" 

 XE "echo (delay)"  (DEL XE "delay (DEL)" ) sets how much time passes before you hear the sound, Attack XE "attack (ATT)"  (ATT) sets the fade-in at the beginning, Hold (HOLD XE "hold" ) sets how long the sound lasts at full volume, and Decay XE "decay (DEC)"  (DEC), Sustain (SUS XE "sustain (SUS)" ), and Release (REL XE "release (REL)" ) control how the sound fades away.  Play with the wheels and watch the graph change.

8. What's LFO XE "LFO" ? LFO stands for Low Frequency Oscillation.  It makes a particular effect oscillate up and down during the life of the sound.  Again, more info is available in the On-Line Help XE "on-line help" , but Amount (AMT XE "amount (AMT)" ) sets how much the effect oscillates, Speed (SPD XE "speed (SPD)" ) sets how quickly it oscillates, Delay XE "delay (echo)" 

 XE "echo (delay)"  (DEL XE "delay (DEL)" ) sets how much time passes before the oscillation starts, and Attack XE "attack (ATT)"  (ATT) sets how quickly the oscillation ramps up to it's full amount.  Play with the knobs and watch the graph change.

9. How do I Use Them? Use the Effect Selector (see diagram above) to choose the effect, and then turn the knobs on either the Envelope XE "envelope"  or the LFO XE "LFO" .  To turn the Envelope on and off for each effect, click on the Indicator Light.  To turn off the LFO, reset the Amount (AMT XE "amount (AMT)" ) to the middle (knob pointing straight up.)

10. Why Can't I Hear the Effect?  Well, if you're still on the Kick Drum from GettingStarted1 XE "Getting Started Loops:GettingStarted1.flp" .flp, it's going to be pretty hard to hear any LFO XE "LFO"  effect, although the Envelope XE "envelope"  might make a difference.  These effects are more audible on longer samples XE "samples" .  To hear the effects better, go to the Instrument Settings for the Ins_Round sample and play with the settings now.

 XE "Lemon Boy"


TWEAKING THE NOTES

By now you're familiar with many of the ways FL Studio lets you tweak and shape your sounds.  In this section, we'll show you how some of those effects can be applied to each dot XE "dots"  separately.  We'll also show you how to program melodies.

1. Check out the Graph Editor XE "graph editor" .  The easiest thing to wrap your mind around is probably the Graph Editor utility.  First, select a channel to edit by clicking on the channel name, or by clicking on the green Channel Selector XE "channel selector light"  light to the right of the channel name.  Then press the button that makes the graph editor pop up as shown below.  (Make sure you've loaded up the original version of GettingStarted1 XE "Getting Started Loops:GettingStarted1.flp" .flp first.)
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2. Check out the Effects.  Try clicking-and-dragging the Effect Selector to see which of the various effects are available.  You should find Pan XE "pan" , Velocity XE "velocity (volume)"  (another name for Volume XE "volume" ), Filter XE "filters"  Cut, Filter Res XE "cutoff & resonance" 

 XE "resonance & cutoff" , Pitch XE "pitch" , and Shift XE "shift" .  Most of these effects were discussed previously, in the "Tweaking the Channels" section.  The difference here is that you can also tweak the value of these effects for each separate dot XE "dots" .  Each bar on the graph sets the effect value for the single note above (or below) it.  GettingStarted1 XE "Getting Started Loops:GettingStarted1.flp" .flp already has some tweaking in it.  Check out the Volume tweaks in the CHH channel and the Cutoff tweaks in the Ins_Square and Ins_Round channels.  

3. Panning XE "pan"  the Kick Drum.  Try setting the pan effect as shown below for GettingStarted1 XE "Getting Started Loops:GettingStarted1.flp" .flp.  The pan graph centers in the middle.  You can set pan values by clicking inside the bar for each note at the desired level.  After you have set up the view shown below, you should hear the kick drum flipping back and forth from one speaker to the other.  This sounds really cool if you combine it with the 3-dot XE "dots"  echo XE "echo (delay)" 

 XE "delay (echo)"  you added in the previous section…
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4. Try the Velocity XE "velocity (volume)" . You can get instruments to fade in and out over a pattern using the velocity graph.  Try this effect on a channel as shown below. This graph does not center in the middle like pan XE "pan" , but goes from zero to maximum, with zero at the bottom.  Volume XE "volume"  slides XE "slide (pitch bend)" 

 XE "pitch bend (slide)"  like this can sound extra cool when combined with Cutoff XE "resonance & cutoff" 

 XE "cutoff & resonance"  and Resonance slides.  (Hint: to make a smooth line in the graph editor XE "graph editor" , right-click on the first bar, then drag the mouse to the right to set the values of all the bars at once.)
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5. Play with the Other Effects.  Try to get a feel for the other effects on the graph editor XE "graph editor" .  Filter XE "filters"  Cut and Filter Res XE "cutoff & resonance" 

 XE "resonance & cutoff"  can be used to add or subtract values to the main cutoff and resonance wheels in the INS XE "channel settings:instrument panel"  panel of the channel settings XE "channel settings"  dialog box. (See the "Tweaking the Channels" section.) Pitch XE "pitch"  makes the sample XE "samples"  higher or lower, like the pitch wheel in the channel settings dialog box.  Shift XE "shift"  can be used to push a dot XE "dots"  closer to the dot beside it (you more musical types can use this to groove a beat).

6. Check out the Melody.  When you play GettingStarted1 XE "Getting Started Loops:GettingStarted1.flp" .flp, that synth melody you hear is being played on the Ins_Round channel.  To see the notes of the melody, click the Keyboard Editor XE "keyboard editor"  button with the Ins_Round channel selected as shown below. What you see now is a vertical piano keyboard for each dot XE "dots"  on the screen.  Hopefully, you have some keyboard skills.  (If not, it's time for some lessons!) You can change each note by left-clicking one of the buttons on the keyboard. Right-click turns the note off. When the loop is not playing, clicking a note will also play that note.
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7. Change the Melody.  Now go ahead and change the melody!  You can make it sound how you want, but below is a suggestion for those who like a note of tension in their music (you can find this melody in GettingStarted2 XE "Getting Started Loops:GettingStarted2.flp" .flp).  You can use the keyboard editor XE "keyboard editor"  on any sample XE "samples"  - synth, bass XE "bass" , guitar, even drums.  Have fun!
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8. Super Important Tip. When you want to make a melody out of long samples XE "samples" , you often need to set it up so that each note cuts off the previous one.  You can do this most easily by right-clicking the Channel Name in the Step Sequencer XE "step sequencer"  and selecting Cut Itself XE "cut itself"  from the pop up menu.  Notice that the Ins_Round channel has this option selected.  Try deselecting it, but be warned - the results can be nasty!
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 XE "Lemon Boy"

 XE "undo"

THE PLAYLIST (from Patterns to Songs)

Now you've seen the basics of what can be done with sampled sounds in a single pattern.  In this section we'll show you how to program more than one pattern and link them together into a longer loop.  Load up GettingStarted2 XE "Getting Started Loops:GettingStarted2.flp" .flp and read on…

1. Check out the Pattern Selector XE "pattern selector" .  FL Studio lets you create hundreds of different patterns.  In the previous sections, we've just been working with pattern 1, but we can access the other patterns either by changing the number in the Pattern Number box. Use your mouse to drag in the Pattern Selector or use numeric ‘1’ till ‘9’ or  ‘+’ and ‘-‘). You’ll find these controls somewhere on the tool bar XE "tool bar"  at the top of the main FL Studio window.
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2. Check out the Playlist XE "playlist" . This screen can be opened using the button under the hint bar XE "hint bar" , or by hitting F5, or by right-clicking the song/pat XE "song/pat" 

 XE "pat/song"  button on the main screen (see above). Try it and you should get a new window that looks something like below. This window is somewhat similar to the pattern view, except that the dots XE "dots"  operate on whole patterns rather than single channels, and the bar lengths here vary to reflect the pattern length. Notice that GettingStarted2 XE "Getting Started Loops:GettingStarted2.flp" .flp consists of pattern 1 repeated 11 times and pattern 2 once at the beginning.  Make sure Song is selected and press Play.  You should see the Play Indicator XE "play indicator"  on the playlist start to move, and hear the patterns it is playing.  When it comes to the end of the dots, it jumps back to the Loop Point XE "loop point"  and continues playing.  Try moving the loop point (right-click where you want it to go) and see what happens. (If you press the Pat button, FL Studio will just repeatedly play the current pattern in the Step Sequencer XE "step sequencer" .)




[image: image18.png]



3. What's the Point? Now you can assemble a number of patterns together to make a song.  This lets you alter melodies, change beats, insert fills, and reuse some of the early parts of the song later.  Many composers use a separate block of patterns for drums, bass XE "bass" , lead, etc. so they can work on them separately at first, and then piece the song together in the Playlist XE "playlist" . 

4. Add Fill Patterns to GettingStarted2 XE "Getting Started Loops:GettingStarted2.flp" .flp.  Here's a simple example.  Select pattern 3 using the Pattern Selector XE "pattern selector"  and then lay it out as shown in the first picture below using the DNC_Snare found in Packs > Dance.  Press the Pat XE "pat/song" 

 XE "song/pat"  button to hear this pattern play.  Then repeat and lay out pattern 4 using the VT_Crash sample found in Packs > Basic >Vintage or DNC_Crash sample found in Packs > Dance (You will have to add two new channels for this by clicking and dragging from the sample XE "samples"  browser XE "sample browser" 

 XE "browser"  or by using the channel menu.)
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 XE "Lemon Boy"
5. Using the Fill in the Song.  Yeah, big deal.  But now lay out the Playlist XE "playlist"  as shown below, and hopefully you'll begin to get the idea.  Note that you need one extra dot XE "dots"  for Pattern 1 and you need to move the Loop Point XE "loop point"  to the second bar (Right-Click to do that.)  You can find the finished product in GettingStarted3 XE "Getting Started Loops:GettingStarted3.flp" .flp.
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 XE "Lemon Boy"
6. What is in Pattern 2?  By now you probably checked out pattern 2 and discovered that it seems to be empty and still appears to be long in the playlist.  All will be revealed eventually (but you could experiment with removing the pattern from the playlist XE "playlist"  to see what difference it makes…). We’ll talk about what pattern 2 does in the section on Live Recording XE "automation" .  For now, just enjoy the ride!


7. What is the Empty Area Below? This feature in FL Studio (Producer edition only) – is for audio tracks and automation envelopes. Audio tracks give you the freedom to see and edit your samples right in the Playlist. A good example of using audio tracks is the startup project itself. Open NewStuff.flp and check the audio tracks area:
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Each track can hold unlimited number of waves (unlike patterns, where each line is a specific pattern). Each wave is actually held in an Audio Clip channel (double click a wave to see its properties). To add a new instance of a wave, just click in an empty place inside the tracks. 

Try moving the waves or cutting them with the slice tool. You can find more tutorial projects explaining how to use them and also plenty of information in the on-line help (focus FL Studio and press F1).
See more info in the chapter Audio Tracks. You can apply automation envelopes (eg. to fade in/out an audio clip) on top of these audio clips.

GENERATORS (from Samples XE "samples"  to Synths)

Up until now we've only been playing with Sample XE "samples"  Channels.  But FL Studio also supports channels that contain sounds made in real time by software synthesizers like Wasp XE "Wasp" , SimSynth Live XE "SimSynth:Live" , and the TS404 XE "TS-404" .  To use the proper terminology, every Channel contains a Generator, which could either be a sample, a synthesizer plugin XE "plugin" , or some other type of sound generator in combination with the effects in the Channel Settings XE "channel settings"  dialog. The combination of these Generators with the sample channels gives FL Studio a major power boost!  

1. Adding a Synthesizer Channel. To add a channel containing a synthesizer Generator, click on Channels > Add One as shown below and select one of the many available like TS404 XE "TS-404" , 3xOsc XE "3xOsc" , BeepMap XE "BeepMap" , BooBass XE "BooBass" , Buzz Generator Adapter (not included in boxed editions) XE "Buzz Generators" , FPC, Fruit Kick XE "Fruit Kick" , Fruity DrumSynth Live XE "Fruity DrumSynth Live" , Fruity DX10 XE "Fruity DX10" , Fruity SoundFont XE "SoundFonts" 

 XE "Fruity SoundFont Player"  Player, Plucked! XE "Plucked!" , SimSynth, Wasp and many others (the list of generators is growing with each release!) XE "Wasp" .  
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2. What to Expect. The new channel will appear in the Step Sequencer XE "step sequencer"  and the Generator's Configuration Screen will appear (except for the TS404 XE "TS-404" ).  If the Configuration Screen is small, it will appear inside a Channel Settings XE "channel settings"  window (3xOsc XE "3xOsc" , BeepMap XE "BeepMap" , Fruit Kick XE "Fruit Kick" , Fruity SoundFont XE "SoundFonts" 

 XE "Fruity SoundFont Player"  Player, Plucked!,… XE "Plucked!" ).  Otherwise, it will appear as a standalone window (BooBass XE "BooBass" , Buzz Generator XE "Buzz Generators" , FPC, Fruity DrumSynth Live XE "Fruity DrumSynth Live" , Fruity DX10 XE "Fruity DX10" , SimSynth Live XE "SimSynth:Live" , Wasp, … XE "Wasp" ).    

3. How Do I Use 'Em? We will review the TS404 XE "TS-404"  in detail in the next section, and much of what you learn there will be applicable to the other synths.  But it's important for you to know that most of these Generators have their own help available.  If the Configuration Screen for the Generator is embedded in a Channel Settings XE "channel settings"  window, click on the channel name.  If it's in a standalone window, click on the corner of the dialog. 
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4. Preset XE "presets"  Sounds.  Many of the synthesizer generators (BeepMap XE "BeepMap" , Buzz Generator XE "Buzz Generators" , Fruit Kick XE "Fruit Kick" , Fruity DrumSynth Live XE "Fruity DrumSynth Live" , Fruity DX10 XE "Fruity DX10" , SimSynth Live XE "SimSynth:Live" , Wasp,… XE "Wasp" ) have preset sounds available.  In most cases, you can get to them from the Presets section of the menu shown above, or by clicking on the little arrows in the top right (see picture above).

5. The Channel Settings XE "channel settings" .  All these generators have a Channel Settings window that you get by clicking on the Channel Name, just like for Sample XE "samples"  Generator Channels.  But since each generator is different, they may not all have the same panels as the Sample Generators do.  For instance, the TS404 XE "TS-404"  has the SMP XE "channel settings:sample panel" , MISC XE "channel settings:misc panel" , and FUNC XE "channel settings:func panel"  panels, while the BeepMap XE "BeepMap"  has INS XE "channel settings:instrument panel" , MISC, and FUNC.

6. What do these Generators Do?  OK, here's the skinny on some of the Generator.  For more info on the TS404 XE "TS-404" , see the next chapter.  For more info on everything else, see the On-Line Help XE "on-line help" .
Please note that  some of these Generators need to be purchased additionally. If you haven’t bought them, you’ll only have the demo version of the Generator that will allow you to listen to its sounds, but these channels will not be saved in your FL Studio project. 

a. TS404 XE "TS-404" .  We get into this in more detail later, but it's a techno machine for creating synth lines and bass XE "bass"  lines, which sound similar to the classic TB-303 XE "TB-303"  machine.
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b. 3xOsc XE "3xOsc" . This is a very plain generator that allows you to mix three Oscillators XE "oscillator (OSC)" , each of which generates a tone.  The sounds on their own are not exciting, but they are good raw material to be combined with INS XE "channel settings:instrument panel"  panel effects and other plugin effects XE "Fruity effects"  (explained in a later chapter).
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c. BeepMap XE "BeepMap" .  This is a weird one.  Takes a bitmap image file and turns it into a sound, with strange and wonderful results. This is the same kind of synth that Aphex Twin XE "Aphex Twin"  used to embed an image of himself in a track that shows up when the track is put through a spectrum analyzer XE "spectrum analyzer" .
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d. BooBass XE "BooBass" . A handy little bass XE "bass"  generator from the guy who brought you SimSynth.
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e. Buzz Generator Adapter XE "Buzz Generators" . Buzz has a bunch of cool, buzzing synth sounds that you can pick from (Rectal Anarchy is shown below). A few “Buzz Machines” come free with FL Studio, but you can find lots more on line at www.BuzzMachines.com XE "BuzzMachines.com" .
For licensing purposes, this generator is not included in the boxed versions of our software.
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f. Dashboard. Allows you to create your own MIDI and Internal Controller interfaces (check the on-line help to see what internal controllers are about).
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g. Fruit Kick XE "Fruit Kick" . A kick drum generator.
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h. Fruity DrumSynth Live XE "Fruity DrumSynth Live" . A Drum Synthesizer plugin XE "plugin"  that lets you define drum hits and control them via a keyboard. 
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i. Fruity DX10 XE "Fruity DX10" . An 8-voice polyphonic (that means 8 notes at once) FM Synthesizer. This one’s designed to give high quality sounds without eating up too much CPU.
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j. Fruity Granulizer XE "Fruity Granulizer" . This one helps you get cool, choppy sound XE "choppy sound" s out of your samples XE "samples" , like when the “Funk Soul Bruvva” sample slows down in Fatboy Slim’s XE "Fatboy Slim"  “Rockefeller Skank”.
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k. Fruity Slicer XE "Fruity Slicer" 

 XE "BeatSlicer" . This one lets you slice up a beat and then play back individual drum hits using the keyboard. You can make cool breaks really quickly with this tool. (More on how this works in the BeatSlicer section below.)
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l. Fruity SoundFont XE "SoundFonts" 

 XE "Fruity SoundFont Player"  Player. An advanced sample XE "samples"  generator that works with the SoundFont2 collection.
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m. Fruity Vibrator XE "Fruity Vibrator" . You can add vibes to your songs using any Force Feedback (.ffe XE "Force Feedback File" ) file. These files can be created using Microsoft Force Editor tool in the DirectX XE "DirectX"  Developer SDK.
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n. Plucked! XE "Plucked!"  A synthesizer that specializes in stringed instrument sounds like guitars, harps, mandolins, etc.


[image: image39.png]Deca,
Y Color

AUCKED | Yk




o. SimSynth Live XE "SimSynth:Live" . A fully functional digital synthesizer.  Use this baby to create phat-sounding analog sounds for your dance and trance tracks.
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p. Wasp XE "Wasp" . Another full digital synthesizer.  This one is better for creating fast, buzzing, techno-oriented sounds (hence the name).
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q. WaveTraveller. Create realistic scratches with a full control over the smallest details!
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r. Layer XE "layer channel" . This isn’t really a Generator, but it’s cool. It lets you create a master channel to control a bunch of other channels at once.

s. MIDI Out XE "MIDI:MIDI Out channel" . This one isn’t a Generator either. It lets you send a MIDI controller XE "MIDI:controllers"  signal to an external (or internal) MIDI device.
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t. FL Keys XE "layer channel" . FL Keys is a realistic piano simulator with optimized CPU and memory usage. 
With the help of several additional modules included in FL Studio, FL Keys can also operate as Rhodes & Roto Organ (note: additional modules might be available from www.flstudio.com).
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u. FL Slayer XE "layer channel" . FL Slayer is a realistic electric guitar simulation originally developed by reFX. It uses a hybrid synthesis similar to physical modeling. The simulator is equipped with a high quality amp section and effects rack enabling you to recreate the complete electric guitar sound without additional plugins.
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v. Sytrus XE "layer channel" . Sytrus is a versatile synthesizer combining Frequency Modulation (FM), Ring Modulation (RM), plucked string modeling and subtracting synthesis, and featuring a powerful envelope editor. The synth includes a powerful editable unison mode and a comprehensive effects section.
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w. Fruity Keyboard Controller XE "layer channel" . Fruity Keyboard Controller is a very useful internal controller plugin, which allows you to map notes and their velocity to any property that can be automated within FL Studio & the loaded plugins. 
This plugin allows you to quickly implement Pattern Controlled Filtering (PCF), or accurate semitone-to-semitone slides for plugins, which do not support natively such features (VSTi and DXi plugins).
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x. Speech Synthesizer  XE "layer channel" .  This is a wizard to add synthesized speech lines to your song (see p.39).

y. Fruity Pad Controller XE "layer channel" .  Hook up any midi controller or use the pianoroll or step-sequencer to trigger our multi velocity layered drum machine to create realistic and convincing drums.
z.  VideoPlayer. Syncs video to the song position for perfect video scoring.
7. Even More Generators! With the Fruity Wrapper XE "Fruity Wrapper"  you can now add any VSTi or DXi plugin XE "plugin"  synthesizer you download or buy. From the Channels menu select Add One > More. This will produce a list of the available plugins as shown below. You can select any of the plugins under the Fruity Generator Plugins heading by double-clicking them.  The “F” in the box beside the plugin name marks it as a “Favorite” and will make it appear directly in the Add One menu.
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8. VST XE "VST plugin"  and DXi Plugins. You’ll notice the Fruity Wrapper XE "Fruity Wrapper"  in the above list. This generator is only to be used for VST and DXi synth plugins, which are listed under the obvious headings in the above picture.  But you don’t need to open it on its own – if you double-click on one of the VST Plugins, it will automatically open a Fruity Wrapper for you. A VST plugin XE "plugin"  synth, confusingly called the mda DX10 XE "mda DX10" , is also available as freeware. 
 Some of the additional Fruity Generators come in Fruity / VSTi / DXi version. This way these generators can also be used natively in other music host programs. 
Please check our website at http://www.flstudio.com/ XE "FruityLoops.com"  for more information about this issue.
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9. The Other VST XE "VST plugin"  Plugins. I know what you’re thinking – what about all the other VST Plugins in the list? VST plugins are either synthesizers or effects (FX), and most of the ones you have to start with are FX (we explain how to use the FX in the Mixing & Effects XE "Fruity effects"  section below). Unfortunately, there is just no reliable way for FL Studio to tell the difference between FX and synth plugins, so you’ll just have to remember which is which.  If you try to open a VST Plugin XE "plugin"  and all you get is an error message and the empty wrapper shown below, then it was probably an FX plugin.
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10. Do I have to register? Some of these products are made by FL Studio partners, so yes in some cases you do have to register them to unlock their full capabilities.  Go to FruityLoops.com" http://www.flstudio.com/

 for more information on where to send your hard-earned cash.

11. Where Can I Get More? There are literally hundreds of synth plugins out there to download.  Some of them are free, and some you have to pay for.  Search the web and FruityLoops.com" http://www.flstudio.com/

 for good deals.  A place you should definitely bookmark is www.kvr-vst.com XE "kvr-vst.com"  - a huge sites with every VST XE "VST plugin"  plugin XE "plugin"  you could possibly want (new VST Plugins should go in the FLStudio4 > Plugins > VST directory on your hard drive).

 XE "Lemon Boy"
 
 XE "Lemon Boy"
12. The Arpeggiator XE "arpeggiator" . Now that we've introduced the Synth generators, we can finally tell you what the Arpeggiator section in the Channel Settings XE "channel settings"  window is for.  Open one of the synth channels XE "synth channels"  (SimSynth Live XE "SimSynth:Live" , for instance) and go to the FUNC XE "channel settings:func panel"  panel of the channel settings box.  Now click the up arrow and select a chord XE "chords" .  Now go to a new pattern and place a single SimSynth note and press play.  Instead of a single note, you get a repeating arpeggio.  Cool, huh?  Read more about this in the on-line help XE "on-line help" .






13. Static Synthesizer Sounds.  FL Studio also contains static support for the standalone version of SimSynth XE "SimSynth: standalone"  and a drum sound synthesizer named DrumSynth XE "DrumSynth" .  If you own either of these pieces of software, FL Studio can read their output files into a normal Sample XE "samples"  Channel.  It is not as flexible as a real synthesizer in FL Studio, but this way you can get the phat sounds of SimSynth without the huge processing load of a real-time synth.  DrumSynth is free from www.mda-vst.com XE "www.mda-vst.com"  and you can get SimSynth at www.flstudio.com XE "FruityLoops.com" . You should find some presets XE "presets"  for both synths in the Browser XE "browser" 

 XE "sample browser" .
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14. Speech XE "Speech Synthesizer" !  Yep, you read that right. You can have a conversation with FL Studio using the built in support for speech synthesis.  The easiest way to access this feature is to look under “speech” in the sample XE "samples"  browser XE "sample browser" 

 XE "browser" , and drag one of the files there onto the step sequencer XE "step sequencer" . You’ll get a dialog that looks like the one below. All you have to do is replace the text, choose a personality, style, rate (speed), and pitch XE "pitch" . Click the “listen” button to hear what it will sound like. When you’re done, press the check mark and a sampler channel will be added. You can also drag a speech file into a Granulizer XE "Fruity Granulizer" , Fruity Scratcher XE "Fruity Scratcher" , or Fruity Slicer XE "Fruity Slicer" 

 XE "BeatSlicer"  channel. Have fun.
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INTRODUCING THE TS404 XE "TS-404" 
The TS404 XE "TS-404"  was originally a standalone synthesizer designed to perform like the classic TB303 bass XE "bass" -line sequencer that gives modern techno it's unique sound.  The 404 is not intended to be an exact replica of that classic machine, but it will still lend a unique techno flavor to your compositions.

1. Add a TS404 XE "TS-404"  Channel.  First of all, load up GettingStarted1 XE "Getting Started Loops:GettingStarted1.flp" .flp. Then add a TS404 channel as shown in the previous section. 

2. Copy the Notes from Ins_Round.  That's right, we're going to replace the Ins_Round sample XE "samples"  with the TS404 XE "TS-404" .  First, use the keyboard editor XE "keyboard editor"  to program the TS404 notes as shown, then click on the Channel Mute XE "mute"  light to turn off the Ins_Round channel and play the result. You may want to turn up the TS404 Channel a little bit too.
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3. Not Too Impressive Yet! OK, so that doesn't sound too good.  That's because you're using the TS404 XE "TS-404"  default settings.  Click on the channel name to bring up the TS404 Channel Settings XE "channel settings"  Dialog as shown below, click the TS404 tab and tweak the controls however you want (one possibility is shown below, with some of the changes pointed out). Our own version can be found in GettingStarted4 XE "Getting Started Loops:GettingStarted4.flp" .flp (actually, you may have to tweak your own version a bit more than what we’ve shown here to make it sound exactly like GettingStarted4.flp).
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4. Understanding the Controls.  Like with the other channel settings XE "channel settings" , this stuff is explained further in the on-line manual.  But for now, here's a brief overview of what the main controls do. There are also lots of other interesting controls you can get to by clicking the MISC XE "channel settings:misc panel" , FUNC XE "channel settings:func panel" , and SMP XE "channel settings:sample panel"  tabs. Have fun, and try to get a feel for it…

 XE "oscillators"

 XE "envelope"

 XE "LFO"

 XE "cutoff & resonance"

 XE "resonance & cutoff"

 XE "amount (AMT)"

 XE "speed (SPD)"

 XE "pitch width (PW)"

 XE "oscillator (OSC)"

 XE "attack (ATT)"

 XE "decay (DEC)"

 XE "release (REL)"

 XE "sustain (SUS)"

 XE "distortion"

 XE "delay (echo)"

 XE "echo (delay)"
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5. Pitch XE "pitch" -bending the 404 XE "TS-404" .  One last thing.  You can bend the notes on the TS404 to make some really cool synth lines.  The TS404 also has a Pitch Bend XE "slide (pitch bend)" 

 XE "pitch bend (slide)"  Line at the top of its keyboard as most of the other synths (but not all of them support it!).  If you click on the Pitch Bend Line, the current note will slide into the next one.  Go back to GettingStarted4 XE "Getting Started Loops:GettingStarted4.flp" .flp and try setting up the keyboard as shown below.  The finished result is in GettingStarted5 XE "Getting Started Loops:GettingStarted5.flp" .flp. Actually, as of version 3.5, this sort of melody is better done using the Piano Roll XE "piano roll" . More on that in a future chapter…
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MIXING & EFFECTS

IMPORTANT REMARK: This guide is a general Getting Started guide for all existing FL Studio Editions. Some features however, are not available in some editions. The FL Studio Fruityloops Edition doesn’t have the Track Adjustments & Mixer sliders capabilities. Please check our site www.flstudio.com  for upgrade conditions.


One great addition to FL Studio Producer Edition is the new Mixer window (previously called Effects Tracks window). You can mix up more than 69 tracks and even make links between them to create complex mixing chains… But wait, let’s start from the very beginning. 

The Mixer window’s best feature is that you can add cool effects to your channels. The effects you can add range from simple things like a volume XE "volume"  control to more advanced effects such as chorus XE "chorus" , reverb XE "reverb" , phaser XE "phaser" , delay XE "echo (delay)" 

 XE "delay (echo)" , flange XE "flanger" , and EQ XE "Equalizer"  among others (you can also add generators, notebooks, controllers, monitors and all kinds of other goodies here too). Remember when we told you to change the FX Track in the TS404 XE "TS-404"  Channel Settings XE "channel settings" ?  Well now we're gonna explain what that was all about.

1. Open the Mixer Window.  Guess what?  The GettingStarted Loops were using Mixer Effects XE "Fruity effects"  all along! Load up one of them and bring up the Mixer screen by pressing F9 or by going to View > Mixer. You'll get a window like the one below…
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2. What You're Lookin' At.  Along the top are the FX Tracks XE "FX Tracks" .  You have one Master Track, 64 Regular Tracks, and 4 Send Tracks. The wheel with the slider below each track is their volume and stereo balance control (just like on a real mixer pult!). 
The insert tracks are displayed 16 at once, but you can switch which 16 tracks you see (click and A/B/C/D switches at the top of the window). The Master Track is selected by default.  Each track has room for eight FX Plugins.  The Getting Started Loops XE "Getting Started Loops"  use the Fruity 7 Band EQ XE "Equalizer"  plugin XE "plugin"  in the Master Track, and the Fruity Delay XE "delay (echo)" 

 XE "echo (delay)"  and Fruity Reverb XE "reverb"  plugins in Track 2.  Try changing the track to find the other plugins.
The Track Adjustments panels show some properties each track has. The volume and stereo balance settings are the same like the one below each track (the other ones are added for convenience, as you see them all, no matter the selected track). The other things on the track adjustments panel are equalizer, stereo “width” knob and a decibel meter (shows the output volume of the track).

3. Turn Plugins On and Off / Mixing Wet and Dry.  Click on the green LED next to each plugin slot XE "plugin"  to turn it on and off.  Try this with the loop running to hear the difference. You can also tweak the knob next to the LED to mix a “dry” (without effect) and “wet” (with the effect) sound.

4. Select Plugins. If you want to add new plugins, click on the arrow where you want to add the plugin XE "plugin"  and then choose from the Favorites List or choose Select to choose from the entire list and configure your favorites.
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5. Tweak the Plugins.  Right-click the plugin XE "plugin"  to open and close its Plugin Settings screen.  Some plugins have a plain interface like the Fruity Fast Dist XE "delay (echo)" 

 XE "echo (delay)"  shown below.  Others have fancier looking controls.  Most plugins come with their own help as shown below, so we won't go into how to use the controls here.  But for now, why not play with them to see what they do?
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6. Sending Sound to the Plugins. Now we can finally explain what the box in the top right of the Channel Settings XE "channel settings"  does.  Any effects placed in the Master FX Track will be applied to all the sounds in the song.  But effects in the numbered Regular FX Tracks XE "FX Tracks"  will only be applied to the Samples XE "samples"  and Synths, which have selected that FX Track in their Channel Settings Dialog.  So, in GettingStarted5 XE "Getting Started Loops:GettingStarted5.flp" .flp, the Ins_Round and TS404 XE "TS-404"  Channels are sending their sound to FX Track 2, where Fruity Reverb XE "reverb"  and Delay XE "delay (echo)" 

 XE "echo (delay)"  will be applied.  The other channels are sending to FX Track 1 (default), which contains no effects.
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7. What are the Send Tracks For? There are 4 special Send Tracks that take their input from other FX Tracks XE "FX Tracks" , rather than from Generator Channels.  Suppose you want to put the same Fruity Reverb XE "reverb"  on Guitar and Drums, but you want to add Fruity Delay XE "delay (echo)" 

 XE "echo (delay)"  to the guitar and EQ XE "Equalizer"  to the drums.  Easy.  Send the drums to Regular FX Track 2 where you put the EQ.  Send the guitar to Regular FX Track 3 where you put the Fruity Delay.  Then put the Reverb in Send Track 1 and turn the Send 1 wheel on Regular FX Tracks 2 and 3 to send the output of these tracks to Send Track 1.  Now you have the same reverb applied to both guitar and drums, but you only had to use a single reverb plugin XE "plugin" .  
The send wheels are placed in the Tracks Adjustments panel for each track.
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8. Changing Plugins Order.  The order in which you add effects plugins has a huge impact on the way the final output sounds. Plugins are like guitar stomp boxes.  On each FX track, the first plugin XE "plugin"  in the list is applied first, and then the output of that plugin is fed to the second, and so on.  To make it easier to experiment with effects order, FL Studio has a simple function to move an effect up or down in the effects chain. It's on the effects menu shown below (Move Up and Move Down.)
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9. What do the Plugins Do?  Like we mentioned, you can get on-line help XE "on-line help"  for all of the FL Studio Plugins, but here's a quick rundown on what they all do…

Buzz Effect Adapter XE "Buzz Effects" . This adapter lets you load in any Buzz Machine effect. FL Studio comes with a bunch installed already, but you can get more at www.BuzzMachines.com XE "BuzzMachines.com" .

Fruity 7 Band EQ XE "Equalizer" . Equalizes your sound (just like on your Dad's stereo at home.)

Fruity Balance XE "balance" . Lets you change the pan XE "pan"  and volume XE "volume"  while live recording XE "live recording" .

Fruity Bass XE "bass"  Boost. Boost that bass for a super-phat sound.

Fruity Big Clock. Pops up a huge timer to tell you how long the song’s been playing.

Fruity Blood Overdrive. Use this to distort channels.

Fruity Center. Use for real time DC offset removal.

Fruity Chorus XE "chorus" . Adds a smooth chorus effect.

Fruity Compressor XE "compression" .  Use this to flatten out the dynamics of the sound.  Apparently Fatboy Slim XE "Fatboy Slim"  uses massive compression to get his drums to sound the way they do…

Fruity DB Meter. Pops up a big levels meter.

Fruity Delay XE "delay (echo)" 

 XE "echo (delay)" . Use for a true echo (not just repeated samples XE "samples"  like the channel echo).


Fruity Delay XE "delay (echo)" 

 XE "echo (delay)"  2. The next generation Fruity Delay. Adds panning XE "pan"  and other effects.


Fruity Fast LP. Use for low pass filtering that's CPU friendly (cutoff XE "resonance & cutoff" 

 XE "cutoff & resonance"  and resonance).

Fruity Fast Dist XE "distortion" . A great little distortion effect that uses almost no CPU.


Fruity Filter XE "filters" . More cutoff XE "resonance & cutoff" 

 XE "cutoff & resonance"  and resonance filtering that’s not so CPU friendly.

Fruity Flanger XE "flanger" . If you have to ask, you haven't heard it yet.  Real popular among guitar players, this LFO XE "LFO" -type effect can add a cool feel to any song.

Fruity Flangus XE "flanger" . A very useful effect, which allows you to enrich the stereo panorama of your instruments, add high quality chorus and simulate unison synthesis.

Fruity Formula Controller. This is a fancy internal controller XE "internal controllers"  that you can link to other wheels and sliders inside FL Studio.  Wait until the Live Recording XE "automation"  section for more info...


Fruity Free Filter XE "filters" . Yet another filter - a classical 12db instead of a state variable filter like the Fruity Filter (whatever the hell that means.) 

Fruity HTML Notebook XE "HTML Notebook" . Add some notes to your loop in html format, or add your own web page!


Fruity LSD. Enables FL Studio to access the DirectMusic Software Synthesizer XE "DirectMusic Software Synthesizer"  bundled with DirectX XE "DirectX"  8. Note that you must have DirectX 8.0 or later installed on your machine. The LSD acts like an external MIDI device, which can be controlled from a MIDI Out XE "MIDI:MIDI Out channel"  Generator Channel (see section on Generators above).

Fruity Mute XE "mute"  2. Use this to mute (silence) channels while live recording XE "live recording" .

Fruity Notebook XE "notebooks" . Keep your song notes here!  This is the plugin XE "plugin"  used in the Tutorial XE "tutorials"  Loops that came with your package.

Fruity PanOMatic. Useful for panning XE "pan"  the sound back and forth smoothly. 

Fruity Parametric EQ XE "Equalizer" . A parametric equalizer built for FL Studio. Regular equalizers only let you set the levels for preset XE "presets"  frequency bands, but with a parametric equalizer you choose the frequency bands to equalize.


Fruity Peak Controller. This is another internal controller XE "internal controllers" . More on controllers in the Live Recording XE "automation"  section below.


Fruity Phase Inverter XE "phase inversion" . Use to reverse the stereo phase (left and right).

Fruity Phaser XE "phaser" . Like the Flanger XE "flanger" , but even cooler.

Fruity Reeverb. Use for a much nicer reverb XE "reverb"  than you can get on the Channel Settings XE "channel settings"  dialog.

Fruity Scratcher XE "Fruity Scratcher" . Load up a sample XE "samples"  and scratch the hell out of it. This plugin XE "plugin"  is actually more like a generator, since it produces sound on its own rather than modifying a channel.

Fruity Send XE "Fruity Send" . Place this plugin XE "plugin"  between two other plugins to split the signal and send it to one of the four  Send FX channels. 

Fruity Soft Clipper XE "Fruity Soft Clipper" . This is a CPU friendly soft limiter filter XE "filters" . It allows you to avoid clipping and distortion XE "distortion"  by applying soft compression to the input signal.

Fruity Spectroman. Pops up a spectrum analyzer XE "spectrum analyzer"  so you can view the spectral distribution of the sounds in your track.

Fruity Stereo Enhancer. Adds some really nice stereo separation and other effects.

Fruity Vocoder. An advanced vocoder with a wide range of adjustable parameters and zero latency (i.e. the vocoded sounds are not “late”). This effect uses quite a lot of CPU with slower machines but has unique precision and features.

Fruity WaveShaper. Is a wave distortion effect which maps input to output values using flexible spline-based graph.
Fruity X-Y Controller XE "Fruity X-Y Controller" . Yet another internal controller XE "internal controllers"  you’ll learn more about in the Live Recording XE "automation"  section below.

10. Preset XE "presets"  Effects. If a plugin XE "plugin"  has built in presets you can access them through the presets section of the effects menu as seen above, or by using the little arrows like with the synthesizer plugins. You can create your own presets by clicking save preset.  When you do this, FL Studio saves the positions of all the plugin controls so that you can get that exact sound back again later.  If you save your presets in the directory FL Studio suggests, then it will appear on the menu under presets.

11. Getting New Plugins. We gave you a great selection of FX Plugins with your FL Studio Package.  But people are always creating new ones, and you can find many of them on the web.  Some are free and some cost money.  Surf the web to see what you can find! The on-line reference (press F1 in FL Studio) contains in-depth step-by-step guides on how to install and use such third party plugins.

12. CPU Considerations. "WOW!! I can use as many plugins as I want?!?" Actually, no you can’t. Each plugin XE "plugin"  you use takes up a certain amount of your computers power. Some take more power than others. The number of plugins you can use before your computer starts grinding and running out of breath depends directly on your CPU speed (you know, that Megahertz thing) and also somewhat on the amount of memory you have. There is no formula for how many plugins you can use, but if the sound starts breaking up after you add a plugin, it’s a good sign that you’ve gone a few plugins too far.  Don't forget about the Send Channels, though.  They can help you cut down on the total number of plugins. Also don’t forget that adjusting the Buffer Length XE "buffer length"  can often solve your CPU problems (see the “What are You Lookin’ At?” section).

RECORDING WITH LIVE TWEAKING

Load up GettingStarted1 XE "Getting Started Loops:GettingStarted1.flp" .flp, open the Channel Settings XE "channel settings"  for Ins_Round, and click on the INS XE "channel settings:instrument panel"  tab.  Now start the loop and watch the cutoff XE "resonance & cutoff" 

 XE "cutoff & resonance"  wheel.  Hey!  It moves while the song is playing!  What's up with that?  That, my friend, is what we call Live Recording XE "automation"  and it's the key to making your songs come alive…
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1. Choose an Automation XE "automation"  Pattern.  OK, this is important.  Finally, we can tell you what Pattern 2 does in GettingStarted1 XE "Getting Started Loops:GettingStarted1.flp" .flp.  It's where the Live Recording data is stored that moves the Ins_Round and Ins_Square cutoff XE "resonance & cutoff" 

 XE "cutoff & resonance"  wheels.  The only way to not tie yourself completely in knots over where you stored your Live Recording data is to always have one pattern where you do your entire Live Recording.  For this song, it happens to be pattern 2.  Then you need to place that pattern in the Playlist XE "playlist"  at the beginning of the song to play back the live tweaking.  As you learn more about what you are doing, you can break out of this mold, but you need to start simple.
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2. Record Some Live Tweaking.  The easiest thing to do is load up GettingStarted5 XE "Getting Started Loops:GettingStarted5.flp" .flp - the one with the TS404 XE "TS-404"  in it.  Open the Channel Settings XE "channel settings"  Dialog, start the song, and practice playing with the CUT XE "resonance & cutoff" 

 XE "cutoff & resonance"  and RES wheels of the TS404.  When you think you've got something groovy, make sure you've selected pattern 2 (the Main Automation XE "automation"  pattern), then press the Record Switch shown below.  You may hear a three-tick XE "tick"  countdown XE "countdown" 

 XE "321 countdown"  first, depending on whether the 321-countdown light is on (see below). Then start the song and work your magic.  The song will play once and then stop.  Turn recording off and press Play.  You've just done your first Live Recording session!



[image: image68.png]


                                      [image: image69.jpg]



3. Set the Buffer Length XE "buffer length"  low.  You may have noticed that there is a short delay XE "echo (delay)" 

 XE "delay (echo)"  between your tweaking and FL Studio's response.  That's controlled by the buffer length (hit F10 and select the Audio tab XE "Audio Settings" ).  The lower you set this slider, the faster FL Studio will respond.  But don't set it too low, or the sound will be choppy (see the "What are You Lookin' At?" section).

4. Important Note. When you've got the Recording Switch on and the loop is playing, moving a wheel will erase over all the previously recorded tweaks from that point in the song until the end.  This can be frustrating, so often it's best to get the recording approximately the way you want it and then make further changes in the Event Editor XE "event editor"  described in the next section.

5. What can be Recorded? Most wheels and sliders are recordable, including those that control Plugins.  But some controls aren't recordable.  The quickest way to tell what's recordable is to mouse over a control and look for the red dots XE "dots"  in the Hint Bar XE "hint bar" .  If these dots appear, then you can record that control.
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THE EVENT EDITOR

Unless you're a real pro, and you have a buffer length XE "buffer length"  of zero milliseconds, you'll probably find that the live recording XE "live recording" s don't always sound exactly perfect.  That's where the event editor XE "event editor"  comes in.  Each time you move a wheel during a recording session, the new setting is stored as an "event" for that wheel at that moment in the loop.  With the event editor, you have complete control over how the sound is tweaked during playback.

1. Record Some Live Tweaking on a Particular Wheel.  The cutoff XE "resonance & cutoff" 

 XE "cutoff & resonance"  on the TS-404 XE "TS-404" , for instance.  Let's assume you already did that in the previous section.  If you prefer you can look at the event editor XE "event editor"  for the INS XE "channel settings:instrument panel"  Cutoff Wheel in GettingStarted1 XE "Getting Started Loops:GettingStarted1.flp" .flp for either the Ins_Round or Ins_Square sample XE "samples" .

2. Stop FL Studio and Open the Event Editor XE "event editor" .  Right-click on the wheel you modified, and select Edit Events from the pop-up menu.  The screen you are looking at now is a lot like the Graph Editor XE "graph editor"  described earlier.  One difference is that this graph controls the level of a single wheel or slider at a particular point in the song.  (OK, it's actually more complicated than that.  Remember how we told you to keep all your live recording XE "live recording"  in a single pattern (Pattern 2) and place this pattern once at the beginning of a song?  If you do that, then the bars in the Event Editor will match the bars in the Playlist XE "playlist" .  If you don't do that, you're on your own!) The other main difference is that this graph is used to set Events (bright vertical lines corresponding to the value of the wheel you are setting) that persist until the next event.  XE "zoom"
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3. Event Editor XE "event editor"  Modes. The event editor has several modes, which are explained below.

a. Draw Mode.  In this mode, the mouse pointer looks like a pencil [image: image72.png]


.  You can add new single events by left clicking in the main window XE "main window" .  You can also left-click and drag to draw multiple events, or right-click and drag to draw a line of events.


b. Brush Mode.  This mode ([image: image73.png]


) is very similar to Draw mode, but ignores snap distance the mouse.

c. Delete Mode.  Click on the delete symbol [image: image74.png]


 to change to this mode.  You can delete events by clicking on them, or click and drag to delete a series of events (the events are the bright vertical lines on the main window XE "main window" .)

d. Smooth Mode.  Click on the smoothing (interpolation) symbol [image: image75.png]


 to change to this mode. You can click and drag to highlight a region. When you let go of the mouse button, the events will be smoothed out, instead of looking choppy. Try it! You can also turn on Auto-Smoothing XE "auto-smoothing"  from the edit menu, so that events you draw in Draw Mode are automatically smoothed out.

e. Select Mode.  Click on the select symbol [image: image76.png]


 to change to this mode.  When you click and drag, you will see a red region highlighted on the Play Indicator XE "play indicator"  Bar. You can also right-click on the Play Indicator Bar in any mode to expand the highlighted region. You can cut and zoom XE "zoom"  to this region from the Edit Menu.

f. Zoom Mode. The zoom mode - [image: image77.png]


 allows you to select an area in the event editor an automatically zoom fit to that area.

4. Miscellaneous Facts.  Here's some stuff you should know about the Event Editor XE "event editor" .

a. Undo XE "undo" . There is a limited form of undo available for the Event Editor XE "event editor" .  Use CTRL-Z to undo the last action.

b. Setting the Initial Event XE "initial event" 

 XE "events (initial)" . You will notice that after live recording XE "live recording" , the wheel you recorded sometimes doesn't start in a sensible place when you play back the loop.  This can be fixed by turning the wheel to a good start position, and then right clicking the wheel and selecting Init Events With This Position. This sets the very first event so that the wheel will always start where you want it.

c. Getting a Feel for It. It takes some practice to master the event editor XE "event editor" , and to be able to get a song to sound exactly the way you want it, but it's definitely worth it.  Keep practicing until you get it right!

d. Live Recording XE "automation"  Defeats Static Tweaking.  If a wheel has some events recorded on it, you can no longer just set it anywhere you want and expect it to stay there.  You have to go through the Event Editor XE "event editor"  or start a new live recording XE "live recording"  session to change it.

5. Introducing the Event LFO XE "LFO" . Earlier on, we explained how to use the LFO (Low Frequency Oscillation) controls on TS404 XE "TS-404"  channels (it's also available for Sample XE "samples"  Channels on the INS XE "channel settings:instrument panel"  panel).  But it's sometimes hard to control exactly how this oscillation is going to fit with the song.  That problem is solved with the Event LFO, which lets you simulate the perfect oscillation inside the event editor XE "event editor" .  

6. Using the Event LFO XE "LFO" . Open the event editor XE "event editor"  for some control (perhaps the Channel Settings XE "channel settings"  INS XE "channel settings:instrument panel"  Panel Cutoff XE "resonance & cutoff" 

 XE "cutoff & resonance"  for Ins_Round in GettingStarted1 XE "Getting Started Loops:GettingStarted1.flp" .flp).  Make sure you're on the right pattern in the pattern selector XE "pattern selector"  (pattern 2 for GettingStarted1.flp).  Now select an area to oscillate using Select Mode or by right-clicking on the Play Indicator XE "play indicator"  Bar.  Now hit ctrl-l or select LFO from the Tools Menu.  This will pop up the LFO Settings window and immediately apply the LFO to the selected area.  See below for an example.
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7. Play with the Main LFO XE "LFO"  Settings.  Notice the dialog has three sections.  If you play with the controls in the Start and Shape sections, you should be able to create all kinds of cool effects.  In the Start section, you can alter the value (height), range (depth XE "depth" ), and speed (length) of the waves.  In the Shape section you can alter the shape of the wave (sine wave, saw-tooth, or square) and the phase (basically moves the waves left and right.) 
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8. What About the End Section?  If you want to make the LFO XE "LFO"  change as it progresses, turn on the End section by pressing the red button.  Once the light is on, you can modify the parameters for the beginning (left) and end (right) of the LFO, and FL Studio will smoothly morph the settings from start to end.  This lets you create really cool changing LFO effects like below.  In the picture, a square wave LFO starts at bar 2 and ends at bar 4.  As the LFO progresses, the speed increases and the value and range decrease from their Start to their End values.
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9. What is in the Edit Menu?  In the Edit Menu you can delete all events (Edit > Delete All), select all events (Edit > Select All), and change the color and look of the editor (Settings).  You can also turn Snap XE "snap to grid"  on and off. Use Snap to make sure your highlighting and event placement is always right on a beat or bar.  The grain of Snap can be changed on the main toolbar XE "tool bar"  (see below).  Try the different settings to see how it effects highlighting and event placement. The finest grain is Tick XE "tick" , which will cause you to snap to extremely fine-grained locations between notes.  If you select Auto, then FL Studio will decide for you where the best snap location is.
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 XE "undo"

THE PIANO ROLL


You may have already realized that there are some things that the Step Sequencer XE "step sequencer"  doesn't do very well.  It gets tricky to use when you have melodies that are longer than 1 bar.  It's also tricky if you want to use a single-note sample XE "samples"  to play chords XE "chords" .  Finally, it's nice to be able to slide XE "slide (pitch bend)" 

 XE "pitch bend (slide)"  notes like on the TS404 XE "TS-404" , but you can't do that with any other type of channel.  The Piano Roll XE "piano roll"  solves all of those problems!

1. Open the Piano Roll XE "piano roll" .  Load up GettingStarted6 XE "Getting Started Loops:GettingStarted6.flp" .flp and select pattern 3.  Notice that the Step Sequencer XE "step sequencer"  view is very different.  That's because the Ins_Round and Ins_Square channels contains Piano Roll data instead of normal dots XE "dots" .  You can open the Piano Roll for any, channel either by right-clicking the channel name or by left-clicking the Mini Piano Roll.  Open it for the Ins_Round channel.
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2. What You're Looking At.  First thing to notice is that this screen looks a little like the Event Editor XE "event editor" .  See the Play Indicator XE "play indicator"  Bar, the Edit Mode Buttons, and the Edit Menu Button?  But the "events" in the Piano Roll XE "piano roll"  are notes to be played at the given location, rather than level settings for various FL Studio controls.  Each horizontal green line shows where a note should start and end, and the Piano Keyboard on the left shows the pitch XE "pitch"  of each note.  The note labeled below is a C5 (C in the 5th octave), which will start on the second beat of the first bar and play for 3/4 of a beat. 

3.  XE "zoom"
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4. Important Advice.  Before we go any further, here's a tip.  Make sure you always keep your Piano Roll XE "piano roll"  patterns separate from your regular patterns.  You'll just avoid a lot of confusion that way. XE "Lemon Boy"
5. What Kinds of Channels Can Have Piano Roll XE "piano roll" s?  You can have a Piano Roll for any type of Generator.  But there's something you should know about Sample XE "samples"  Channels.  You can use the Piano Roll on any Sample Channel, but it will always work best when you are using Looped Samples XE "loop point" .  Ins_Round, for instance, contains loop points that let the sample play over and over again to create a smooth sound that lasts as long as you want.  If you don't have a looped sample, you can still use the Piano Roll, but your notes may not actually last as long as you wanted them to.

[image: image84.png]PAD_Cloud.wav

Wave, Loop,
5 U oop i
. Ping pang o

Precomputed effects.
. Remoue 0C ofset .| Reverse ol

. Nomaize . Fade serzn

. Revarze

Susp seren





6. Basic Piano Roll XE "piano roll"  Editing.  Here's a run-down of how to edit your melody line.

a. Entering Notes.   To enter a note, make sure you're in Draw Mode by clicking the Draw Mode Button (see the Event Editor XE "event editor"  section) or the Paint Mode Button, click on the canvas, and drag the note to where you want it to start.  If the loop is not playing, you should hear the note you are entering as you drag it around. The length of the note will match the length of the last note you placed.  To change the length, grab the right hand side of the green bar and drag it.  

b. Note Snap XE "snap to grid" .  You may find the note snaps to a place you didn't want it to go.  If so, change the Snap Level on the main toolbar XE "tool bar"  the same way as you did for the Event Editor XE "event editor"  (see previous section).  Sometimes you just can't get the note length to snap where you want no matter what you do.  In this case, shrink the note to the left as far as you can and then drag it out to the right again.  This often fixes the problem.

c. Note Color. See the row of 4 colored buttons under the Edit Mode Buttons?  These let you select the color of the notes you enter.  This may seem foolish right now, but color-coding can really help you out when you're trying to make sense of the notes you entered.  Plus, the Edit Menu lets you Select By Color so you can Delete or Copy and Paste only those notes.

d. Deleting Notes.  Two options here - either right click the note you want to delete or go into Delete mode with the Delete Mode Button (see the Event Editor XE "event editor"  Section).

e. Undoing XE "undo"  Changes. Like the Event Editor XE "event editor" , there is a limited undo available from the Edit Menu or by pressing Ctrl-Z.

f. Cutting, Copying and Pasting Notes.  Go into Select Mode with the Select Mode Button (see Event Editor XE "event editor"  section) and click and drag to highlight some notes.  Then use the Cut, Copy and Paste options in the Edit Menu or use Ctrl-C, Ctrl-X, and Ctrl-V.  Pasting can get a little tricky, though.  The notes will paste to their identical locations in the first bar that is currently displayed on the screen.  So to paste from bar 1 to bar 2, select the notes in bar 1 and hit Ctrl-C to copy, then scroll over to bar 2 and hit Ctrl-V.  If the notes don't appear, they probably went into bar 1.  Press Ctrl-Z to undo XE "undo"  and try again.

7. Chords XE "chords"  and Harmonies.  One of the really nice features of the Piano Roll XE "piano roll"  is that you can have notes sound on top of each other to create chords and harmonies.  Here, we're getting into sophisticated stuff that you need some kind of musical intuition for, but FL Studio does make life a little easier by giving you a Chord option on the Edit Menu.  Select the type of chord you want, and then go into Draw Mode.  You can now drop entire chords onto the canvas.  GettingStarted7 XE "Getting Started Loops:GettingStarted7.flp" .flp is an example of a melody with harmonies.  The picture below is a snapshot from that project:
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8. Pitch XE "pitch" -Bending Notes.  This is really cool.  If you click on the Slide XE "slide (pitch bend)" 

 XE "pitch bend (slide)"  Icon in the top left just under the Edit Menu Button, you can insert pitch-bending notes (also called Slide Notes).  To see how this feature works, place a long note on the canvas, and then place a slide note above or below it.  Make sure the two notes overlap.  The long note will play until it reaches the slide portion.  Then the pitch will rise towards the Slide Note and stay there until it reaches the end of the original note. The longer the Slide Note, the longer the slide.  In GettingStarted8 XE "Getting Started Loops:GettingStarted8.flp" .flp, we've added another Ins_Round Piano Roll XE "piano roll"  in pattern 4 that uses slides.  Check it out.
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9. Tweaking the Notes.  Remember the Graph Editor XE "graph editor"  from way back in the Step Sequencer XE "step sequencer"  section?  It let you individually change Volume XE "volume" , Cutoff XE "resonance & cutoff" 

 XE "cutoff & resonance" , Resonance and so on for each note.  The Piano Roll XE "piano roll"  has a similar function, laid out in the bottom part of the Piano Roll Editor.  Every time you enter a note, you get a spike in the bottom graph that shows the level of the parameter selected by the drop down box on the left (labeled Event Select above).  After you enter the notes, you can change the values of any of the parameters by grabbing the top of the spikes and dragging them. GettingStarted8 XE "Getting Started Loops:GettingStarted8.flp" .flp has volume tweaks in the Piano Rolls for both pattern 3 and 4. You can set Velocity XE "velocity (volume)" , Pan XE "pan" , Cutoff, Resonance, and Pitch XE "pitch" .  As an added bonus, you can also use this graph as the Event Editor XE "event editor"  for Channel Pan, Pitch, and Volume.  NOTE: You can also change a note’s properties by double-clicking it.

10. Importing XE "import"  MIDI Tunes.  In the File Menu under MIDI, you'll find two methods of importing MIDI sound files directly into the Piano Roll XE "piano roll"  Editor. There are tons of MIDI files XE "MIDI:files"  for various popular melodies floating around out there.  Now you can suck them directly into FL Studio and use them in your songs.  How cool is that?

AUDIO TRACKS



IMPORTANT REMARK: This guide is a general Getting Started guide for all existing FL Studio Editions. Some features however, are not available in some editions. The FL Studio Fruityloops Edition doesn’t have Audio Track or the Integrated Wave Editor capabilities. Please check our site www.flstudio.com  for upgrade conditions.
FL Studio Producer Edition let you work with Audio Tracks and automation envelopes.
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The bottom section of the playlist contains the audio/automation. 


The bottom section of the playlist contains the audio/automation tracks (9). The tracks provide the user with an easy visual way to place, arrange and edit a set of audio clips and parameter automation splines, with an intuitive preview of the data held in the clips (waveforms/automation splines - see the picture). It is also possible to cut and split clips in multiple pieces and arrange the pieces independently on the audio tracks.

Each clip available in the tracks view is in fact an instance of the Audio Clip generator or the Automation Clip.

Audio clips: are a special version of the Sampler channels.

Automation clips: are a dedicated internal controller plugin. 

Each clip channel you add in the Step Sequencer becomes available in the tracks view and vice versa - dropping samples on the audio tracks generates an Audio Clip channel (unless a channel exists with the same sample).
The audio tracks provide you with an easy visual way to arrange a set of large audio clips, while seeing the waveform preview inside the tracks. You can cut and split the audio clips in multiple pieces and arrange the pieces independently on the audio tracks.

Each audio clip, available in the audio tracks, is in fact an instance of the Audio Clip generator. 
Each Audio Clip channel you add in the Step Sequencer becomes available in the audio tracks and vice versa - dropping samples on the audio tracks generates an Audio Clip channel (unless a channel exists with the same sample).

To place an audio clip, switch to draw or paint mode and left-click in an audio track (if no Audio Clip channels exist, you will see a dialog where you can browse for a sample to be used). 
Paint mode allows you to draw multiple instances of the audio clip at once (hold the mouse button and drag).

To erase an audio clip, click it with your right mouse button or use the left mouse button in erase mode.

To switch an audio clip instance to play another Audio Clip channel, open the clip menu (left-click the arrow in the top left corner of the clip) and from the Select Channel menu, pick an Audio Clip channel to switch to.


To open the Channel Settings of the channel associated with the audio clip instance, open the clip menu and select Channel Settings.

From the clip menu, select Preview to listen to the audio clip sample (hit the Stop button in the Transport panel to stop the preview).

Automation clips can automate any editable parameter over the complete song (instead of pattern based automation). A common use of these automation clips is to make a fade-in/out for an audio clip by automating its volume.

However, the use of automation clips has a much bigger scope than controlling the clips volume. Feel free to experiment with its use.

Use the appropriate switch to switch between Audio clips handling and Automation clips handling.

INTEGRATED WAVE EDITOR



IMPORTANT REMARK: This guide is a general Getting Started guide for all existing FL Studio Editions. Some features however, are not available in some editions. The FL Studio Fruityloops Edition doesn’t have Audio Track or the Integrated Wave Editor capabilities. Please check our site www.flstudio.com  for upgrade conditions.
FL Studio Producer Edition includes an integrated wave editor, which allows you to edit samples quickly and effortlessly without having to use external applications.
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The editor allows you to do all basic operations over the samples, such as fade in/out, record normalize volume etc. You can edit any sample by opening its Channel Settings and pressing CTRL+E, or by opening the Channel Settings menu and selecting the Edit command.

 XE "Lemon Boy"
THE BEATSLICER

In yet another awesome FL Studio team-up, you can now import XE "import"  beats sliced up into separate drum hits using the BeatSlicer XE "BeatSlicer" .  This is really handy if you're into break beats.  Here's how you do it…

1. Select Import XE "import" (Beat to Slice from the File menu.

2. Select a Beat.  The first thing you'll be asked to do is select a wav file XE "wav:files"  to slice.  Make sure it's at least a 1 bar (1 pattern long) beat.  You can slice a file that's not a beat, but it won't work very well…

3. Decide where to put the sliced beat. Next you will be asked to choose the directory for the sliced beat. This is where the separate wave files (each containing one drum hit) will be put. FL Studio already has a default directory you can use, called “Sliced Beats”.
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4. Decide How You Want the Beat? You will get the dialog box shown below.  You have the choice of: a) using a single sampler channel for each slice of the beat (“Sampler Channels”); b) using a Layer XE "layer channel"  to group the channels (“Layered Sampler Channels”); or c) putting the whole beat in a single channel using the Fruity Slicer XE "Fruity Slicer" 

 XE "BeatSlicer"  (“Slicer Channel”).
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5. To Merge or Not To Merge.  Final question - do you want to merge the beat with the current project? If so, click off the light on the above dialog that says “Start New Project”. The beat will be inserted into the first pattern of your song.  Because of this, you should probably insert a blank pattern at the start of the song before you slice.  You can do this with ctrl-insert in the Playlist XE "playlist" .  

6. Save Your Changes.  If you start a new project, you will be asked whether to save the current one (if it was altered since last save).  

7. The Final Result.  On the next page is a picture of what a sliced beat (using the “Sampler Channels” option) looks like in FL Studio.  Note that if you choose to start a new project, the tempo XE "tempo" 

 XE "speed (tempo)"  is automatically chosen to match the tempo of the original beat. Also, since no beat ever quite fits exactly onto the notes, FL Studio has used the shift XE "shift"  function (see the graph editor XE "graph editor"  pane) to match the beats exactly. Now rearrange the beat for funky breaks!

8. Don’t forget about the Fruity Slicer XE "Fruity Slicer" 

 XE "BeatSlicer"  Plugin XE "plugin"  that we told you about in the Generators section. It’s another handy way to use the FL Studio/BeatSlicer team-up without going through the elaborate process detailed here.
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 XE "import"

 XE "ReBirth"
 XE "TB-303"

 XE "TR-808"
 XE "TR-909"

 XE "Lemon Boy"
SHARING YOUR WORK

So now you’re done with your song – you probably want to bring it out of FL Studio so you can put it on a CD, post it on the Internet, or edit it in another program. The Export XE "export"  function exists for this purpose. Here's how to use it.

1. Export XE "export"  to Wav XE "wav:export to wav"  or MP3 XE "MP3" . This option is available from the File menu. Whether you choose Wav or MP3, you will be asked to specify the name of the file and then the dialog below will appear.  There's a lot to choose from here, and we're not gonna go into it.  If you want an explanation of every button, go to the on-line help XE "on-line help"  under File Formats.  It's all there.  If you want to just get your song rendered, leave the settings the way they are (trust us - we picked the defaults for a reason!)
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 XE "Lemon Boy"
2. Should I Use Wav or MP3 XE "MP3" ?  Wav is a raw sound file format.  Huge files, excellent sound quality (expect to use about 10 MB per minute depending on Depth XE "depth" ).  Wav files are suitable for burning onto CD.  MP3 is a compressed format.  Smaller files, but sound quality may be slightly compromised (expect to use about 1 MB per minute depending on Bit Rate XE "bit rate" ).  If you want to share files on the Internet, MP3 is the way to go.

3. Should I Use "Background Rendering XE "background rendering" ?"  Rendering can take a long time and hogs the CPU, especially if you choose the high-quality options in the Quality section of the window above.  But if you click on Background Rendering, FL Studio will iconify itself and continue to render unobtrusively in the background.  It takes longer, though.

4. Exporting XE "export"  to a Zipped Loop Package XE "zipped loop packages" .  This feature is useful if you want to transmit your FL Studio files over the web. It takes your FL Studio file, plus all the samples XE "samples"  used in that files, and puts them into one zip file.

5. Project Bones XE "project bones"  and Project Data Files XE "project data files" . These options let you save a lot of the information about your track. The Project Bones option saves a file with all your presets XE "presets" , automation XE "automation"  information, and so on to be loaded later. Project Data Files saves all the samples XE "samples"  and other raw data you used to a single location on your hard drive.

6. Where Can I Put My Songs? There are a number of places on the web where artists can place their music in MP3 XE "MP3"  format for free.  www.mp3.com XE "mp3.com"  is probably the best-known site, but it's easy for an amateur looper to get buried there in all the high-profile commercial stuff.   www.sectionz.com XE "SectionZ.net"  is an option if you are more interested in feedback from other musicians who use FL Studio. The site is a musical community with people like you reviewing every song that is placed on the site. It's a great way to get feedback.  If you don't like either of these options, you can always create your own site using one of the many free hosting services out there.  Good luck!

 XE "Lemon Boy"


EXTERNAL CONTROLLERS

An External MIDI Controller XE "MIDI:controllers"  is kind of like a big fancy joystick to control the wheels and switches in FL Studio.  The main difference is that you have to tell FL Studio ahead of time what you want each knob on the controller to do (a minor inconvenience for the luxury of changing both cutoff XE "resonance & cutoff" 

 XE "cutoff & resonance"  and resonance at the same time!)  Each knob on the controller can be linked to a different wheel or slider on FL Studio.  If you have a controller, this section will tell you how to make it work with FL Studio.  If you don't have one, get one!  First we'll introduce a few of the more popular controllers, and then we'll tell you how to set them up.

1. A Few Examples of MIDI Controllers XE "MIDI:controllers" .    
a. The PhatBoy XE "PhatBoy" . The PhatBoy is one of the most affordable (hence most popular) MIDI controllers XE "MIDI:controllers" , made by KeyFax at www.keyfax.com XE "Keyfax.com" .  It's small, with only 13 knobs, but that's as big as most people will ever need (you've only got two hands!).

 XE "Lemon Boy"
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b. The DrehBank XE "DrehBank" .  Another popular choice is the DrehBank from Doepfer at www.doepfer.de XE "Doepfer.de" .  This baby gives you 64 knobs instead of 13!
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            The Boss

c. Other Controllers XE "MC-505" .  
The Korg MicroKONTROL, Edirol PCR-50 and MC-505 by Roland (www.rolandgroove.com XE "RolandGroove.com" ) are some of the many other controllers that can be used with FL Studio. The MC-505 is a lot more than a MIDI controller XE "MIDI:controllers" .  It's a hardware synthesizer and sequencer specially built to replicate classic techno sounds like the TB-303 XE "TB-303" , TR-808 XE "TR-808"  and TR-909 XE "TR-909" .  But it also has full MIDI controller capabilities, so you can link some of the knobs to FL Studio controls.

 XE "Lemon Boy"
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2. Setting Up Your Controller.   

a. Get a MIDI Cable XE "MIDI:cables"  and Plug in your Controller.  Look on the back of your computer.  If you see two or three round, 5-pin connectors labeled "MIDI", then you're in business.  If not, look for a 15-pin trapezoidal joystick port.  If you have the round connectors, you need a cable to go from "MIDI Out XE "MIDI:MIDI Out channel" " on your controller to "MIDI In" on your computer.  If you only have a game controller connection, you'll need a special cable that has two round MIDI plugs at one end and a trapezoidal plug at the other.  Both these types of cables should be available at any music store specializing in keyboards and synthesizers (but if you ask for them in a computer store, you may just get blank looks.)

b. Turn on the Controller and Start Up FL Studio. If you have a PhatBoy XE "PhatBoy" , make sure the power switch is set to mode "III".  If you have a DrehBank XE "DrehBank" , hold down the "Bank 1" button when you plug in the power cable.  For the MC-505 XE "MC-505" , make sure the MIDI mode is set to MODE 2 (Shift XE "shift"  12, Edit TxRx = Mode2). Try turning the knobs on your controller.  If everything is ok, you should see a little red "Midi" light flash beside the Hint Bar XE "hint bar"  of FL Studio every time you turn a knob.  If that works, great!  You can skip steps c to e.  If not, read on my friend.
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c. Enable MIDI Remote Control XE "MIDI:controllers" . Check the Options menu to see if there is a check mark beside MIDI Remote Control. If not, click on it and see if you get the light now.  If not, read on.



[image: image98.png]



           hERETIC XE "hERETIC" 
d. Set Your MIDI Input Device XE "MIDI:controllers" .  If the light is still not coming on when you turn knobs on your controller, go into MIDI Settings XE "MIDI:settings"  (from the Options menu or by hitting F10).  Check out the Remote Control Input XE "remote control input"  box.  If you see the word "none" there, then you've got to select an input.  Typically, you will be presented with a number of choices, and you'll just have to try them all to figure out which one is right.

 XE "Lemon Boy"
e. Troubleshooting XE "troubleshooting"  Checklist.  If the red light is still not coming on when you turn the knobs on your controller, here's a list of things you should check.

* Did you select the correct PhatBoy XE "PhatBoy"  or DrehBank XE "DrehBank"  mode in step b?

* Did you enable "MIDI Remote Control XE "MIDI:controllers" " in step c?

* Did you select the correct MIDI input in step d?

* Are your MIDI In and Out cables reversed?

* Did you plug the controller into a power outlet?
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       Jaha XE "Jaha" 
3. Linking a wheel to Your Controller.  OK, load up any loop you have that uses the TS-404 XE "TS-404"  channel.  GettingStarted4 XE "Getting Started Loops:GettingStarted4.flp" .flp might be a good one to start with.  

a. Right-click on the Control You Want to Link to the MIDI Device.  In this case, we're trying the main volume XE "volume"  control on a TS404 XE "TS-404" .  Now click on Link to MIDI Controller XE "MIDI:controllers" , to pop up the Remote Controlling Settings window.
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b. Turn a Knob on Your Controller.  You should see the Channel and Controller numbers change.  Now click OK, and turn the same knob.  You should see the volume XE "volume"  control turn back and forth and hear the volume of the instrument change.  You're in business!

c. Set the Buffer Length XE "buffer length"  as Low as You Can.  Earlier, we explained the buffer length slider (get to it by hitting F10 and clicking the Audio tab XE "Audio Settings" ).  This slider determines the delay XE "echo (delay)" 

 XE "delay (echo)"  time between you turning a knob and the sound of FL Studio changing.  So you want to set it low.  But if you set it too low, the sound will become choppy.  So try to find a happy medium.  If you can't get it low enough to do what you want, then I guess you need a faster computer. Sorry, dude.

4. Which Controls Can I Link? Pretty much all of them, actually.  For reference, though, it's the same set of controls that can be changed in Live Recording XE "automation" .  Again, if you want to know whether a control can be linked externally and live recorded, mouse over it and look for the two red dots XE "dots"  in the Hint Bar XE "hint bar" .  

5. What About Internal Controllers XE "internal controllers" ? Finally, we can tell you about the Internal Controller Plugins listed in the Effects XE "Fruity effects"  section (the Formula Controller, Peak Controller, and X-Y Controller). These are plugins with controllers, which can XE "plugin"  set other controls. Did you follow that? Let’s take the Fruity X-Y Controller XE "Fruity X-Y Controller"  as an example. Open the plugins window (F9) and put a Fruity X-Y Controller on the master FX track.
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a. The Fruity X-Y Controller XE "Fruity X-Y Controller"  lets you control two wheels at once by linking one wheel to its X (horizontal) dimension and one wheel to its Y (vertical) dimension. Then you can grab the circle in the main window XE "main window"  and as you pull it around, it changes both controls that it is linked to.  It’s particularly handy for controlling cutoff XE "resonance & cutoff" 

 XE "cutoff & resonance"  and resonance at the same time. Load up GettingStarted7 XE "Getting Started Loops:GettingStarted7.flp" .flp again, re-install XE "installation"  the Fruity X-Y Controller as in step 5 and open the INS XE "channel settings:instrument panel"  panel of the Ins_Round channel.  Then right-click the Cutoff and select Link to External Controller.
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b. Link the Cutoff XE "resonance & cutoff" 

 XE "cutoff & resonance"  wheel to the X value of the internal controller XE "internal controllers" , as shown above. Now link the Resonance wheel to the Y value. Then open up the Fruity X-Y Controller XE "Fruity X-Y Controller"  window, start the loop, and drag the circle around to listen to the Cutoff and Resonance changing at the same time. Cool, huh?  XE "Lemon Boy"

 XE "FruityLoops.com"
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Click the INS Tab





Click Here





This FX Track Sends its Output to Send Track 2





Sending to 


FX Track 2





Click Here for Help





Left OR Right Click This Bar





FX Plugins





FX Tracks





You're a Techno god.





Can't click off the pitch-bend line? Try right and left clicking.  One of em's gotta work!





New Notes





Pitch Bend Line








Automation 


Tracks





The oscillators: You can have two slightly different sounds playing at once.  Click on the little pictures for different waveforms.  Set the octave by turning the CRS wheel.





Oscillator mixing: Turn the MIX wheel to hear more or less of oscillator 1 and 2.





The Filters: Cutoff and Resonance.  Try the buttons too (Lo12, etc).





The Envelope: Attack, decay, release, sustain, etc. (Check out the little picture!)





Distortion: Turn up both wheels for a nastier sound.





LFO: Low frequency oscillation.  This function slowly turns a parameter such as the CUToff up and down.  Try turning up the amount (AMT) and the speed (SPD).  Then try playing with the buttons to make the RESonance, tuning (OSC) and pitch width (PW) oscillate.





That's a little better…





Last Thing to Do: Turn these wheels slowly while the song plays…





Make the Sound Trashier





Make the Notes Decay Slower





Audio tracks





Change the FX Track (We'll explain this later)





Umm… I liked it better before…





Add the 


Notes





Turn Up 


the TS404





Mute This Channel





Importing ReBirth RB-338 Songs. You might have noticed this option in the Import Menu...  This feature allows you to open a ReBirth song, configure it to FL Studio Format, and listen in FL Studio. Of course, it's not a perfect conversion - see the pop-up window for details about what parts of the song might not be converted properly.  The playlist and pattern layout also needs some explaining.  The first 32 patterns are TB303 #1.  The next 32 are TB303 #2.  Then you have 32 patterns for the TR808 and another 32 for the TR909 for a total of 128 patterns.  Of course most of these will probably be blank for any given song, so your song ends up pretty spread out, but it's all there if you hunt for it.�









Help





Arpeggiator: This gets explained in the Generators section of this guide.











HEY! Don't skip that step.  This guide will work a lot better if you're looking at the example loops while you read…





Lemon Boy is in the house: Yo, whassup!  Having problems? Before you panic and start spamming the FL Studio Tech Support, look for me.  I'll pop up here and there with answers to common problems that might save you (and the FL Studio staff) some trouble.











Groovy.





Big deal…





Pattern 4





Pattern 3





Play Indicator





Song Mode





Record Switch





Song/Pat 


Button





Patterns


(right-click to rename)








Bars





Loop Point





Description





Red Dots





Remember to Select the Right Pattern During Live Recording!





Play Indicator





QuickPad


(sometimes disabled)





Pattern Selector





Channel Selector





Keyboard Editor





Keyboard Editor Button





Channel Selector





Effect Selector





Graph Editor





Graph Editor Button








Now we're cookin' with gas!





Getting Echo Time Just Right: The "Time" control is fine-grained to get you just the exact echo you want.  But if you want to echo on the beat, you will have to look at the Hint Bar while you turn the dial. If you want the echo every three dots, just turn the dial until the hint bar shows "3:00". 








Pan, Cut, and Res do the same job as on the sample panel, but the effects build up as the echo dies out.  





Pitch controls the pitch of the echo.  If you turn this wheel right, the echo will get higher as it dies out.





Ech: Number of times the instrument will echo before it stops.





Time: Controls the amount of time (in dots) between each echo.  Maximum delay time is 16 dots.











Feed: Echo volume (sets how quickly the echo dies out). 








Ping Pong: Makes the echo flip back and forth from left to right (sounds cool on headphones).  








Can't hear the difference?  If you press a button or turn a wheel and you can't hear any difference in the sound, try making the same change on another channel.  For example, sometimes a change that doesn't affect a kick drum much will make a huge difference to the sound of a snare.  If you still can't hear the difference, stop the loop from playing and listen the sounds separately by clicking on the wave view window.  You might be able to hear the effect better without the other instruments.




















Track Adjustments








Remove DC Offset: Use this option to fix “vertical” offset in the samples (see Wave View below).


Reverse Polarity: "Flips" the waveform vertically. 


Normalize: Maximizes the sample volume without distortion. 


Fade Stereo: Creates a stereo fade from the left to the right channel of the sample. 


Reverse: Reverses the sample. 


Swap Stereo: Switches left and right channel of the sample.





Audio /


Automation 


Switch








Wave View Window: Shows the shape of the sound sample. Click here to hear the sample with all the effects .  Also a drag and drop window for loading samples.








Fade In (IN): Applies a quick fade in to the sample (turn maximum to left to disable). 


Fade Out (OUT): Applies a quick fade out to the sample (turn maximum to left to disable). 


Pitch bend (POGO): Applies pitch bend to the sample. Useful with drum samples. 


Crossfade Loop (CRF): Allows you to crossfade the sample for the creation of smooth loop sections (turn maximum to left to disable). 


Trim Threshold (TRIM): FL Studio trims the silence at the end of the samples, as this frees up RAM and does not alter the resulting sound. This control allows you to raise the volume threshold below which FL Studio detects "silence".





Vol, Pan: These are the volume and panning wheels that also appear on the main screen for each channel.  Turning these will make the wheels on the main screen turn as well.








Pitch: The wheel changes the pitch of the sample (speeds it up or slows it down).  The number indicates how far the pitch wheel can stretch.  Move it by clicking and dragging.








Then Here





Then Here





Click Here





Lost the Browser? No problem.  The five big buttons on the tool bar shown below will open and close various windows for you, including the Browser and the Step Sequencer.  (Don't worry about those other windows for now, all will become clear in the fullness of time…)





�





Channel Selector





Sample File Name





Click Here





Wait! What's a "sample"? A sample is a little piece of sound stored in a disk file.  Each channel in FL Studio uses a single sample, usually containing a single note (like a snare drum hit or a single bass note), but they can also contain entire beats or tunes.  Samples are usually ".wav" file types, but FL Studio supports ".xi" sound files too.








Don't Save!  If you create a masterpiece and you want to keep it, at least save it under a new name.  We need you to keep GettingStarted1.flp around so we can use it to explain some of the more advanced features later.





Watch this Wheel Move!





Channel Controls





Suggested Changes





A Channel


Name





A Channel





Some Dots








Edit mode selection





Using Loop Points





Edit menu





Overlapping Notes





Are you ready to rock? 





horizontal position





Plugins.  You can do live tweaking recording on most Plugins, but not all of them.  Experiment to find out.





Dude!  That looks complicated…





LemonBoy's Live Tweaking Recording Advice…





* Always, always, always check the pattern selector before you start recording!!!





* Try to get your song laid out the way you want it before you start live recording.  Once you have events recorded, it is difficult to change the layout of the playlist in a way that will still sound good.





* Always save a backup copy of your loop before you start any live recording.  That way if you mess things up or change your mind, you can go back to the clean copy.





* Save your loop frequently during live recording.  If you accidentally tweak something and erase some events, you can always go back to the previous version.





* Get yourself an External MIDI Controller to make your life easier (See the section on External Controllers for more info!)





Play Indicator








Events  


(Each sets the level until the next event)





Sam: Yo, check it out. I need a cable with MIDI connections on one end and a joystick plug on the other.  





Computer Store Guy: What's mee dee?





Loop Points





Time for more tips





* You can undo an LFO with Ctrl-Z.





* If you record tempo changes, the delay line for the TS-404 will automatically be reset at every change.  The delay lines for the sample channels will not, but the delay length will change with the tempo, making it sound a little weird at first. 





Whoa!  Talk about bringin' a gun to a knife fight!





Only I may own a Drehbank.  They are not for manual writers!





Who you callin' phat?





Man, this thing just keeps gettin' better!





Left Click Here


(Mini Piano Roll)





C5 





Display


Mode





Play Indicator





Edit Mode 


Buttons





Edit Menu





Right Click Here


(Channel Name)





If your Midi controller seizes up on ya… Try this as a last resort: quit Fruity, then select Programs > FL Studio > Advanced > Reset settings from the Windows Start menu.  Then relaunch Fruity and try again…





The Little Red Light





Slide


Icon





Note Starts





Slides 


Up





Slides Down





Then


Stops








Event Select








Click Here





Then Here





Step Sequencer





Effect Selector





Envelope





LFO





Set Middle Note





Indicator Light





Don't deny yourself, dude!  You need all these generators.  Save up your squeegee money and buy them ASAP.





SimSynth





DrumSynth
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Snap Toolbar
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Please don’t forget to consult the extended and detailed online help that comes with your FL Studio.


Just push F1 to call the context sensitive online help.





This guide is only intended to get you started. 


If you are in need of more details, the online help will tell you everything you need to know about the FL Studio features, the generators and its effects.





If you have troubles getting started with FL Studio and your hardware, just try the ‘Setup Wizard’ in the online help.





Don’t forget that our website � HYPERLINK "http://www.FLStudio.com" ��www.FLStudio.com� contains a lot of information. You will find interactive tutorials, video tutorials, F.A.Q section, technical support forum and a lively FL Studio community.





Be a part of this community and register your version at our site.





Now go get that record deal!
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Well, that’s it. Have fun! Don’t forget there’s more help available inside FLStudio and on line at � HYPERLINK "http://www.FLStudio.com" ��www.FLStudio.com�.





Preset Sounds





Direction of Arpeggio





Chord Selection





Octave Range


and Repeat








Speed, Duration, etc.








A big round of applause for the FLStudio team!





DX10





DreamStation is an example of a DXi plugin





( me… me… me… (


( me… me… me… ( 


( meeee… 
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Change the Oscillator Shapes 





Effects have presets too…





Count in





Vertical/�Horizontal Zoom �(click + drag) 





Big News!  You can now undo the last tweak! Do it from the Edit Menu or with ctrl-z.








Zoom





� EMBED Word.Picture.8  ���





� EMBED Word.Picture.8  ���





Click the TS404 Tab





You might have to spell some words funny to make it sound ok… Also, you can make it sing by putting the number of semitones you want the pitch to rise on each word in brackets after it. Try typing “all your(2) base(3) are(2) beelong to us” in the dialog above (use a monotone style.)
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